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Preface

Intended Audience
Welcome to Release 12.1 of the Oracle Value Chain Planning Installation Guide.

See Related Information Sources on page vii for more Oracle E-Business Suite product 
information. 

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at http://www.oracle.com/us/corporate/accessibility/ 

Structure
1  Oracle Value Chain Planning Installation
2  Advanced Planning Command Center
3  Production Scheduling
4  Strategic Network Optimization
5  Service Parts Planning
6  Demand Signal Repository
7  Rapid Planning
8  Other Useful Information

Related Information Sources
Open Source Disclosure

The Advanced Planning applications have embedded within them a variety of third 
party software components, each of which has its own copyright and licensing terms. 
The Advanced Planning applications containing third party components from the 
development organizations identified below are identified in the parenthetical 
following the name of the organization.
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Apache Software Foundation

Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include 
the following acknowledgment:

"This product includes software developed by the Apache Software Foundation (
http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and 
wherever such third-party acknowledgments normally appear.

4. The names "Apache" and "Apache Software Foundation" must not be used to 
endorse or promote products derived from this software without prior written 
permission. For written permission, please contact apache@apache.org.

Products derived from this software may not be called "Apache", nor may "Apache" 
appear in their name, without prior written permission of the Apache Software 
Foundation.

THIS SOFTWARE IS PROVIDED "AS IS"' AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf 
of the Apache Software Foundation. For more information on the Apache Software 
Foundation, please see <http://www.apache.org/>.

Portions of this software are based upon public domain software originally written at 
the National Center for Supercomputing Applications, University of Illinois, 
Urbana-Champaign.

http://www.apache.org/
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ptmalloc

Copyright (c) 1999 Wolfram Gloger

Permission to use, copy, modify, distribute, and sell this software and its 
documentation for any purpose is hereby granted without fee, provided that (i) the 
above copyright notices and this permission notice appear in all copies of the software 
and related documentation, and (ii) the name of Wolfram Gloger may not be used in 
any advertising or publicity relating to the software.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY 
KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, 
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. IN NO EVENT SHALL WOLFRAM GLOGER BE LIABLE FOR ANY 
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY 
KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF 
DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Sleepycat Software

Copyright (c) 1990, 1993, 1994 The Regents of the University of California. All rights 
reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

• All advertising materials mentioning features or use of this software must display 
the following acknowledgement:

This product includes software developed by the University of California, Berkeley 
and its contributors.

Neither the name of the University nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
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USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Tool Command Language (TCL)

This software is copyrighted by the Regents of the University of California, Sun 
Microsystems, Inc., Scriptics Corporation, ActiveState Corporation and other parties. 
The following terms apply to all files associated with the software unless explicitly 
disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this 
software and its documentation for any purpose, provided that existing copyright 
notices are retained in all copies and that this notice is included verbatim in any 
distributions. No written agreement, license, or royalty fee is required for any of the 
authorized uses. Modifications to this software may be copyrighted by their authors 
and need not follow the licensing terms described here, provided that the new terms are
clearly indicated on the first page of each file where they apply.

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY 
PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, ITS 
DOCUMENTATION, OR ANY DERIVATIVES THEREOF, EVEN IF THE AUTHORS 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND 
NON-INFRINGEMENT. THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS, AND
THE AUTHORS AND DISTRIBUTORS HAVE NO OBLIGATION TO PROVIDE 
MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

GOVERNMENT USE: If you are acquiring this software on behalf of the U.S. 
government, the Government shall have only "Restricted Rights" in the software and 
related documentation as defined in the Federal Acquisition Regulations (FARs) in 
Clause 52.227.19 (c) (2). If you are acquiring the software on behalf of the Department of
Defense, the software shall be classified as "Commercial Computer Software" and the 
Government shall have only "Restricted Rights" as defined in Clause 252.227-7013 (c) (1)
of DFARs. Notwithstanding the foregoing, the authors grant the U.S. Government and 
others acting in its behalf permission to use and distribute the software in accordance 
with the terms specified in this license.

Independent JPEG Group

This product includes software developed by the Independent JPEG Group. Copyright 
(c) 1991-1998 The authors make NO WARRANTY or representation, either express or 
implied, with respect to this software, its quality, accuracy, merchantability, or fitness 
for a particular purpose. This software is provided "AS IS", and you, its user, assume 
the entire risk as to its quality and accuracy.
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Henry Spencer's Regular Expression Library (REGEX)

This product includes software developed by Henry Spencer. Copyright (c) 1992, 1993, 
1994, 1997 This software is not subject to any license of the American Telephone and 
Telegraph Company or of the Regents of the University of California. Permission is 
granted to anyone to use this software for any purpose on any computer system, and to 
alter it and redistribute it, subject to the following restrictions:

• The author is not responsible for the consequences of use of this software, no matter
how awful, even if they arise from flaws in it.

• The origin of this software must not be misrepresented, either by explicit claim or 
by omission. Since few users ever read sources, credits must appear in the 
documentation.

• Altered versions must be plainly marked as such, and must not be misrepresented 
as being the original software. Since few users ever read sources, credits must 
appear in the documentation.

• This notice may not be removed or altered.

XBAE

Copyright (c) 1991, 1992 Bell Communications Research, Inc. (Bellcore)

Copyright (c) 1995-99 Andrew Lister

All Rights Reserved.

Permission to use, copy, modify and distribute this material for any purpose and 
without fee is hereby granted, provided that the above copyright notices and this 
permission notice appear in all copies, and that the name of any author not be used in 
advertising or publicity pertaining to this material without the specific, prior written 
permission of an authorized representative of Bellcore and current maintainer.

BELLCORE AND OTHER CONTRIBUTORS MAKE NO REPRESENTATIONS AND 
EXTEND NO WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THE 
INFORMATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR 
PURPOSE, AND THE WARRANTY AGAINST INFRINGEMENT OF PATENTS OR 
OTHER INTELLECTUAL PROPERTY RIGHTS. THE SOFTWARE IS PROVIDED "AS 
IS", AND IN NO EVENT SHALL ANY AUTHOR OR ANY OF THEIR AFFILIATES BE 
LIABLE FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES RELATING TO THE 
INFORMATION.

Oracle

Oracle takes no responsibility for its use or distribution of any open source or 
shareware software or documentation and disclaims any and all liability or damages 
resulting from use of said software or documentation.
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Integration Repository
The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your 
instance is patched, the repository is automatically updated with content appropriate 
for the precise revisions of interfaces in your environment. 

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Oracle Value Chain Planning Installation

This chapter covers the following topics:

• About this Document

• Purpose

• Scope and Application

• Before Applying the Feature Pack

• Product-Specific Installation Tasks

About this Document
Note: Application Install - Oracle Value Chain Planning 12.1.3.2. 
Information in this document applies to any platform.

Purpose
This document contains instructions for customers who plan to upgrade an existing 
Oracle Value Chain Planning system to 12.1 Release Update Pack 3 (12.1 RUP3) and 
then to release 12.1.3.2 (patch 10192383 
[https://updates.oracle.com/ARULink/PatchDetails/process_form?patch_num=10192383
]). 

You should read and understand all the tasks described in these installation instructions
before you begin the installation.

Scope and Application
The intended audience for this document:

• Business User: Provides knowledge and guidance regarding application 

https://updates.oracle.com/ARULink/PatchDetails/process_form?patch_num=10192383
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functionality.

• Database Administrator: Installs and configures the Oracle database and maintains 
database access controls.

• System Administrator: Responsible for administering systems. 

Complete the tasks in the following sections in the order listed. Updated versions of the 
patches and documents listed in this section may be available. Check My Oracle 
Support or contact Oracle Support Services for the latest versions.

Tasks included in these instructions require use of the AutoPatch, AD Administration, 
and other AD utilities. Tasks included in these instructions upgrade the following 
Oracle Value Chain Planning products to Release 12.1.3 level: 

• Advanced Supply Chain Planning

• Demand Planning

• Inventory Optimization

• Global Order Promising

• Collaborative Planning

• Production Scheduling

• Strategic Network Optimization

• Service Parts Planning

• Advanced Planning Command Center

• Demand Signal Repository

• Rapid Planning

Before Applying the Feature Pack
To purchase this product, please contact an Oracle Sales Representative, by calling 
1-888-ORACLEi (1-888-672-2534). 

Before performing the product specific installation steps in this document, you must 
have already installed the following patch: 

• Oracle Value Chain Planning 12.1.3 PATCH, R12.SCP_PF.B

The patch for the 12.1.3.2 release is Oracle Value Chain Planning 12.1.3.2 PATCH 
10192383 

https://updates.oracle.com/ARULink/PatchDetails/process_form?patch_num=10192383
https://updates.oracle.com/ARULink/PatchDetails/process_form?patch_num=10192383
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[https://updates.oracle.com/ARULink/PatchDetails/process_form?patch_num=10192383
], R12.SCP_PF.B.

Product-Specific Installation Tasks
After you apply E-Business Suite Application Release 12.1.3 Media Pack, for each 
product that you intend to use, follow the product-specific installation steps in this 
document.
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2
Advanced Planning Command Center

This chapter covers the following topics:

• Setting Translated Messages

• Setting Up RPD Translated Messages

• Troubleshooting

• Using Webcenter for APCC

Setting Translated Messages
Due to enhancements related to RPD translation compatibility, Both English-only and 
non-English users are required to setup RPD translated as documented in readme of 
8629912:R12.MSC.B APCC TRANSLATION ONE-OFF FOR 12.1. The following is 
extracted from that readme.

To verify whether RPD translated messages is setup properly, user may:

• Create new report in OBIEE Answers.

• Expand Columns > Facts > Forecasting.

• See reporting currency value columns are show correctly (such as "Budget (CAD)" 
etc.).

To set up RPD translated messages, it requires user to have the following:

• Connection information of EBS database.

• APPS access to EBS database.

• XDK TransX tool (such as Oracle client with XDK option).
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Setting Up RPD Translated Messages
Perform the procedure below.

1. Stop all OBIEE services.

2. Unzip $MSC_TOP/patch/115/obiee/apcc-obiee-en.zip. 

3. Locate appc_en.dlf file extracted.

4. Run following as APPS database user:
delete from msc_translated_message where lang_id='en';
commit;

5. Import appc_en.dlf into database.
transx "(connection_string)" apps (password) (path)\appc_en.dlf

Example
%XDK_HOME%\bin\transx "rws60050rems:1617:ma0dv211" apps apps 
D:\appc_en.dlf

6. Check msc_translated_message is populated from appc_en.dlf.
select count(*) from msc_translated_message where lang_id='en';

7. Start all OBIEE services.

Troubleshooting
If TransX doesn't run due to missing classes, it's most likely that class path is not set 
properly. Following sample shows setting CLASSPATH variable for Windows 10g 
client with XDK option:

Example
set XDK_HOME=D:\Oracle\product\10.2.0\client_1
    set CLASSPATH=%XDK_HOME%\LIB\xmlparserv2.jar;
  %XDK_HOME%\LIB\xsu12.jar;%XDK_HOME%\LIB\oraclexsql.jar;
  %XDK_HOME%\LIB\transx.zip;%XDK_HOME%\jdbc\lib\classes12dms.jar;
  %XDK_HOME%\jdbc\lib\ojdbc14.jar;
  %XDK_HOME%\LIB\servlet.jar;
  %XDK_HOME%\RDBMS\jlib\xdb.jar;%CLASSPATH%

For more XDK information, refer to Oracle XDK documentation.

Using Webcenter for APCC
This topic provides information about using Webcenter with APCC.
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Prerequisites
Verify the information below.

1. Verify that weblogic/webcenter/soa components are installed by following the My 
Oracle Support note 1074345.1 
[https://support.us.oracle.com/CSP/main/article?cmd=show&id=1074345.1&type=N
OT].

2. Verify UCM is installed and configured properly [optional].

3. Verify that VCP 12.1.3 patch [9482453:R12.SCP_PF.B] or later is installed.

Configuring Webcenter
To configure Webcenter for Oracle Advanced Planning Command Center perform the 
following:

1. Deploy and configure the spaces servlet, page 2-3.

2. Deploy and configure the BPM Tasklist, page 2-5.

3. Deploy and configure the group space Template, page 2-8.

4. Deploy and configure the application links [Optional], page 2-9.

5. Deploy and configure the SOA BPEL flows, page 2-14.

6. Set up profile options, page 2-16.

7. Compile MscWCRedirect.jsp, page 2-19.

8. Run the Planning Process Activities concurrent process, page 2-19.

9. Change the Webcenter application name, page 2-20.

Deploy and Configure the Spaces Servlet
Perform the procedures below to deploy and configure the spaces servlet.

1. Obtain file mscspacesservlet.ear from 
$MSC_TOP/patch/115/ear/mscspacesservlet.ear.

2. Copy it to your local directory in Linux Session.

3. Open the Webcenter Console for the Webcenter domain.

https://support.us.oracle.com/CSP/main/article?cmd=show&id=1074345.1&type=NOT
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4. Log in to the Webcenter Console.

5. Click Lock and Edit > Goto Domain Structure.

6. Click Deployments.

7. Click Install.

8. Click link upload your file(s).

9. Search for your .ear file in the deployment archive and select the .ear file to deploy.

10. Click Next, select Managed Server WLS_Spaces, deploy .ear file, and click Finish.

11. After this finishes deployment to the managed server, click the Release 
Configuration.

12. If the state of deployment of mscspacesservlet is Prepared, click Lock and Edit > 
Deployments, select deployment mscspacesservlet, click Start, click Servicing all 
requests, click Release Configuration. Verify that the deployment status of 
mscspacesservlet changes to Active.

13. To generate Java keystore in the Webcenter instance, go to JDK_HOME/jdk/bin and 
open a command prompt.

14. Execute the following keytool run commands to generate keystore producer.jks: 
keytool -genkeypair -keyalg RSA -dname 
"cn=producer,dc=example,dc=com" -alias producer -keypass welcome1 
-keystore /scratch/dumakant/keystore/samedomain/producer.jks 
-storepass welcome1 -validity 365
 keytool -exportcert -v -alias producer -keystore 
/scratch/dumakant/keystore/samedomain/producer.jks -storepass 
welcome1 -rfc -file producer.cert
 keytool -importcert -alias webcenter_spaces_ws -file producer.cert 
-keystore /scratch/dumakant/keystore/samedomain/producer.jks 
-storepass welcome1

/scratch/dumakant/keystore/samedomain/ can be your local Linux home path. 

Set the value of recipient key alias in profile option MSC: APCC Webcenter Spaces 
Recipient Key Alias.

15. Connect to the Webcenter server using telnet.

16. Execute the following command:
cd /slot/ems2995/appmgr/Oracle/Middleware/user_projects/
domains/wc_domain/config/fmwconfig/

17. Copy producer.jks to this location.
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18. Open jps-config.xml.

19. Change serviceInstance as follows:
serviceInstance name="keystore" provider="keystore.provider" 
location="./default-keystore.jks" to location="./producer.jks"

20. Run command wlst. 

21. Connect to the Webcenter using the following command line:
connect('weblogic','welcome1', 'Webcenter host:port')

For example, for Webcenter host:port, use dadvmi0029.us.oracle.com:7060.

22. Back up cwallet.sso.

23. Execute the following:
createCred(map="oracle.wsm.security",key="enc-csf-key",user="produce
r",password="welcome1",desc="Enc Password")
 
createCred(map="oracle.wsm.security",key="sign-csf-key",user="produc
er",password="welcome1",desc="Enc Password")
 
createCred(map="oracle.wsm.security",key="keystore-csf-key",user="ke
ystore-csf-key",password="welcome1",desc="Keystore password")

24. Restart the Webcenter servers.

Deploy and Configure the BPM Tasklist
Perform the following procedures to deploy and configure the BPM Tasklist.

Create a Directory and Set a Path
1. Create directory /tmp/tasklist and set path as follows:

/Oracle/Middleware/jdk160_11/bin/:$PATH

Update and Copy the .war File to the Webcenter Home
1. Get file msc_custom_spaces.zip from ARU and unzip it to obtain 

custom.webcenter.spaces.war. Then, unjar it. Execute the following:
cd /tmp/tasklist;
 unzip msc_custom_spaces.zip
 cd /tmp/tasklist;
 jar xvf custom.webcenter.spaces.war;

2. Go to WEB-INF/lib/ and unjar wf_client_custom.jar. Execute the following:
cd /tmp/tasklist/WEB-INF/lib;
mkdir temp;
cp wf_client_custom.jar temp/
cd temp;
jar xvf wf_client_custom.jar
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3. Open wf_client_config.xml and provide your soa server URL for tagsserverURL 
and rootEndPointURL.

4. Update wf_client_custom.jar with the updated wf_client_config.xml. Execute the 
following:
cd /tmp/tasklist/WEB-INF/lib/temp;
jar uvf wf_client_custom.jar wf_client_config.xml

5. Copy file wf_client_custom.jar to WEB-INF/lib/. Execute the following:
cp /tmp/tasklist/WEB-INF/lib/temp/wf_client_custom.jar ../
cd /tmp/tasklist/WEB-INF/lib/;
rm -rf temp;

6. Update custom.webcenter.spaces.war with updated file 
WEB-INF/lib/wf_client_custom.jar and all other files that were part of 
custom.webcenter.spaces.war. After executing these commands, there is updated 
custom.webcenter.spaces.war at /tmp/:
cd /tmp/tasklist;
jar uvf custom.webcenter.spaces.war WEB-INF/lib/wf_client_custom.jar

7. To back up, execute the following: 
/slot/ems4372/appmgr/oracle/middleware/Oracle_WC1/webcenter/
modules/oracle.webcenter.spaces_11.1.1/
custom.webcenter.spaces.war
cd /slot/ems4372/appmgr/oracle/middleware/Oracle_WC1/
webcenter/modules/oracle.webcenter.spaces_11.1.1/
cp custom.webcenter.spaces.war custom.webcenter.spaces.war.orig

8. Copy custom.webcenter.spaces.war. Execute the following: 
/slot/ems4372/appmgr/oracle/middleware/Oracle_WC1/webcenter/
modules/oracle.webcenter.spaces_11.1.1/
cd /slot/ems4372/appmgr/oracle/middleware/Oracle_WC1/webcenter/
modules/oracle.webcenter.spaces_11.1.1/
cp /tmp/custom.webcenter.spaces.war

Update Deployments
1. Navigate to http://rws60212rems:7004/console/ using weblogic/welcome1 and click 

button Lock & Edit.

2. Click Deployments, select webcenter, click Stop, select option Force Stop Now, and 
answer Yes to the confirmation question.

3. Re-select webcenter, click Delete, and answer Yes to the confirmation question.

4. Select custom.webcenter.spaces, click Update, click Next, click Next, and click 
Finish.

5. Click Install. Select path as follows:
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/slot/ems4372/appmgr/oracle/middleware/Oracle_WC1/archives/applicati
ons, and file as webcenter.ear

Deploy it on managed server WLS_Spaces.

6. Click Deployments, select webcenter, click Start, select option Start servicing all 
requests, and answer Yes to the confirmation question.

Set extendApp to true in setDomain.sh.
1. Open 

/slot/ems4372/appmgr/oracle/middleware/user_projects/domains/wc_domain/bin/s
etDomainEnv.sh and add the following:
EXTRA_JAVA_PROPERTIES="-Doracle.webcenter.spaces.extendApp=true 
${EXTRA_JAVA_PROPERTIES}"
export EXTRA_JAVA_PROPERTIES

2. Restart managed server WLS_Spaces.

Create a New View in Oracle BPM Worklist
1. Navigate to the BPM worklist [http://rws60212rems:8880/integration/worklistapp] 

and log in using admin credentials.

2. Click the Add [+] icon from section Worklist Views.

3. Select Create View, select name APCC Shared View, select Add to Standard Views. 
Navigate to Add Condition drilldown and select State. Click the Add [+] icon, select
Assignees who can share this view.

4. Select Display tab, then select these columns in the left side of the window:

• Title: BPEL process name that you created in the Scenario Manager 

• Due Date 

• Application Context: BPEL Activity Name

• Identifier: Plan name 

• State: Worklist task state--Assigned, Deleted, Suspended

• Category: BPEL Activity Status - In progress, Not Started, Error or Completed

• Created: Date 

• Creator: User

5. Click OK.
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Test the Tasklist
1. Navigate to Webcenter [http://rws60212rems:8877/webcenter/] and log in.

2. Create a blank group space, edit page, click add content. The Catalog opens. 

3. Click open on APCC Custom Folder, move to Task List, and click Add.

4. Verify that it is added to the Tasklist.

Deploy and Configure the Group Space Template
1. Get file msc_apcc_gs_template.ear from ARU.

2. Copy it to your local directory.

3. Open the Webcenter Spaces URL. 

Example
http://rws60212rems.us.oracle.com:8877/webcenter

4. Log in to the Webcenter Spaces URL.

5. Navigate to the Webcenter Administrator.

6. Click the Manage Group Spaces and Group Space Templates. Manage Group 
Spaces opens.

7. Click the Templates subtab. The Manage Group Space Templates window opens.

8. Click the Import option. The Import Archive Name window opens.

9. Select Option Archive Located on Local File System, specify local directory as the 
EAR file location, and click the Import button. This completes the group space 
template import.

10. Log in to the Webcenter Spaces URL.

11. Click Group Spaces.

12. Click Create Group Space.

13. Enter Group Space Name, enter Description, and select group space template name.

14. Click Create. This creates a group space with group space name given.

15. Click Group Space Name tab.

16. Navigate to Setting > Custom Attributes.
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17. Select custom attribute FND_OBIEE_URL.

18. Navigate to Actions, and select Edit Attribute.

19. Enter your OBIEE URL. 

Example
http://adc60069fems.us.oracle.com:9799/

20. Click OK.

21. Select custom attribute APPS_SERVLET_AGENT.

22. Navigate to Actions, and select Edit Attribute.

23. Enter Apps Servlet URL.

Example
http://rws60147rems.us.oracle.com:8034/OA_HTML

24. Click OK.

25. Select custom attribute MSC_SCN_SERVICE_ENDPOINT.

26. Navigate to Actions, and select Edit Attribute.

27. Enter the BPM Worklist URL.

Example
http://rws60018rems.us.oracle.com:8880

28. Click OK.

29. Navigate to the home page, click Edit Page, delete the worklist component from top
of the page, and place APCC Custom Folder > Tasklist at the same location. This 
replaces a worklist component with a tasklist component.

30. Navigate to the Setting tab, and then navigate to the General tab.

31. Click Save as Group Space Template. The Save as Group Space Template window 
opens.

32. Enter Template Name, enter Description, and check Publish.

33. Click Save. This creates the template.

34. Enter the template name in MSC: APCC Webcenter Group Space Template Profile.
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Deploy and Configure Application Links [Optional]
This configures e-Business Suite functions as external applications in the Webcenter 
Personal Sidebar; the user can navigate to e-Business Suite from Webcenter. 

Group space also contains application links with context-like group space names, but 
application Links defined in Webcenter Personal Sidebar do not pass context 
information to e-Business Suite applications.

1. Open enterprise manager [http://host:port/em] and log in as administrator 
[weblogic/welcome1].

2. Expand Webcenter, expand Webcenter spaces, select webcenter (WLS Spaces), 
right-click Settings, and click Service Configuration.

3. Select External Applications.

4. Click the Add icon, input values for these entities, and click OK. 

Some of these are sample values:

• Application Name: Scenarios

• Display Name: Scenarios

• Enable Automatic Login: Selected

• Login URL: 
http://host:port/OA_HTML/MscObieeSrvlt?ParamType=Name&FROM_NODE=W
C&TO_NODE=SCN

• Find the values for the host and port from the value of profile option Apps 
Servlet Agent.

• HTML User ID Field Name: usernameField

• HTML User Password Field Name: passwordField

• Authentication Method: Post

• Enable Shared Credentials: Selected

• User Name: TEST

• Password: TEST

5. Click the Add icon, input values for these entities, and click OK.

Some of these are sample values:
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• Application Name: Supply Chain Analyst Dashboard

• Display Name: Supply Chain Analyst Dashboard

• Enable Automatic Login: Selected

• Login URL:
http://host:port/OA_HTML/MscObieeSrvlt?ParamType=Name&FROM_NODE=W
C&TO_NODE=SCA

Find the values for the host and port from the value of profile option Apps 
Servlet Agent.

• HTML User ID Field Name: usernameField

• HTML User Password Field Name: passwordField

• Authentication Method: Post

• Enable Shared Credentials: Selected

• User Name: TEST

• Password: TEST

6. Click the Add icon, input values for these entities, and click OK. 

Some of these are sample values:

• Application Name: Sales and Operations Planning Analyst Dashboard

• Display Name: Sales and Operations Planning Analyst Dashboard

• Enable Automatic Login: Selected

• Login URL:
http://host:port/OA_HTML/MscObieeSrvlt?ParamType=Name&FROM_NODE=W
C&TO_NODE=SOP

Find the values for the host and port from the value of profile option Apps 
Servlet Agent.

• HTML User ID Field Name: usernameField

• HTML User Password Field Name: passwordField

• Authentication Method: Post

• Enable Shared Credentials: Selected
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• User Name: TEST

• Password: TEST

7. Click the Add icon, input values for these entities, and click OK. 

Some of these are sample values:

• Application Name: Simulation Planner Workbench

• Display Name: Simulation Planner Workbench

• Enable Automatic Login: Selected

• Login URL:
http://host:port/OA_HTML/MscObieeSrvlt?ParamType=Name&FROM_NODE=W
C&TO_NODE=rp

Find the values for the host and port from the value of profile option Apps 
Servlet Agent.

• HTML User ID Field Name: usernameField

• HTML User Password Field Name: passwordField

• Authentication Method: Post

• Enable Shared Credentials: Selected

• User Name: TEST

• Password: TEST

8. Click the Add icon, input values for these entities, and click OK. 

Some of these are sample values:

• Application Name: Demand Management Workbench

• Display Name: Demand Management Workbench

• Enable Automatic Login: Selected

• Login URL: 
http://host:port/OA_HTML/MscObieeSrvlt?ParamType=Name&FROM_NODE=W
C&TO_NODE=DEMANTRA

Find the values for the host and port from the value of profile option Apps 
Servlet Agent.
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• HTML User ID Field Name: usernameField

• HTML User Password Field Name: passwordField

• Authentication Method: Post

• Enable Shared Credentials: Selected

• User Name: TEST

• Password: TEST

9. Click the Add icon, input values for these entities, and click OK.

Some of these are sample values:

• Application Name: BPM Worklist

• Display Name: BPM Worklist

• Enable Automatic Login: Selected

• Login URL:
http://host:port/integration/worklistapp

Find the values for the host and port from the value of profile option MSC: Scn 
Service End Point.

• HTML User ID Field Name: usernameField

• HTML User Password Field Name: passwordField

• Authentication Method: Post

• Enable Shared Credentials: Selected

• User Name: TEST

• Password: TEST

10. Open Webcenter spaces [http://host:port/webcenter] and log in as administrator 
[weblogic/welcome1].

11. Navigate to the top menu, select the Administration, and click Integrate Existing 
Applications.

12. Expand Applications Node, select Scenarios, and click Edit. For each application, 
change Open Behavior to the Webcenter tab, and click OK.
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Deploy and Configure SOA BPEL Flows
You can deploy and configure SOA BPEL flows using the one of the options below.

Option A: BPEL Deployment for EBS 12.1.3
1. Uptake 9499809:R12.TXK.B.

2. In WebLogic Administration Console create a JDBC Data Source connection, name 
it CustomerDBConnection, and, for Database Driver, select Oracle's Driver (Thin) 
for Instance Connections; Version:9.0.1,9.2.0,10,11. Click Next. Clear Supports 
Global Transactions option, and then click Next. For JNDI Name, use 
jdbc/CustomerDBConnectionDS. Provide all the database information required, set 
Initial Capacity to 0 and click Next. Test your connection, and on the next page, 
select soa_server1.

3. Follow MSC flow deployment steps in My Oracle Support note 1070257.1 
[https://support.us.oracle.com/CSP/main/article?cmd=show&id=1070257.1&type=N
OT]. 

Option B: BPEL Deployment for VCP 12.1.3/VCP 12.1.2
1. In the WebLogic Administration Console, create a JDBC Data Source connection, 

name it CustomerDBConnection, and, for Database Driver, select Oracle's Driver 
(Thin) for Instance Connections; Version:9.0.1,9.2.0,10,11. Click Next. Clear 
Supports Global Transactions option, then click Next. For JNDI Name, use 
jdbc/CustomerDBConnectionDS. Provide all the database information required, set 
Initial Capacity to 0, and click Next. Test your connection, and on the next page, 
select soa_server1.

2. In the WebLogic Administration Console, navigate to soa_server1 > Deployments. 
From the list, click DbAdapter. Navigate to Configuration > Outbound Connection 
Pool, and create a New connection pool using javax.resource.cci.Coonectionfactory 
as Outbound Connection Groups , use eis/DB/CustomerDBConnection for the JNDI
Name , then click Finish. Open the Connection (eis/DB/CustomerDBConnection) 
and set DataSourceName to jdbc/CustomerDBConnectionDS (the data source 
created before). 

• If SSO is enabled on WebLogic, EBS users will get authenticated on WebLogic.

• If the SSO is not enabled on WebLogic, please create EBS users who will 
create/start the BPEL flows on the WebLogic side. 

• Deploy file msc_ws_todoworklist_ws.ear (from 
$MSC_TOP/patch/115/ear/soa11j) on the soa server and set Context Root to 
MSC-WS-TODOWORKLIST.

3. Deploy msc_ws_bpelprocess_ws.ear (from $MSC_TOP/patch/115/ear/soa11j) under 
<SOA_DOMAIN>selecting Application Deployments, Context root - 

https://support.us.oracle.com/CSP/main/article?cmd=show&id=1070257.1&type=NOT
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MSC-WS-BPELSeedUtil 

4. Move all files sca_*.jar and file MscJarBuild.xml file under the same directory and 
execute the following:
ant -buildfile MscJarBuild.xml
  -DnewDbConnName=<DB CONNECTION NAME>
  -DnewDwURL=<DEMANTRA WORKFLOW URL>
  -DnewSoaURL=<SOA SERVER URL>

<DB CONNECTION NAME> is CustomerDBConnection

<DEMANTRA WORKFLOW URL>is the Oracle Demantra Workflows Web service 
end point. For example, http://ap7001dma.us.oracle.com/mz121ut1. 

<SOA SERVER URL> is WebLogic soa component URL.

Example
http://rws60018rems.us.oracle.com:8880

An example of the command appears below.
ant -buildfile MscJarBuild.xml
  -DnewDbConnName=CustomerDBConnection
  -DnewDwURL=http://ap7001dma.us.oracle.com/mz121ut1
  -DnewSoaRL=http://rws60018rems.us.oracle.com:8880

After the ant command finishes successfully, verify that there is a new directory 
EbsModifiedBpelJars and that it contains the modified BPEL jar files.

This example shows how to set up the ant command on a Linux machine with 
Oracle Middleware installed:

• Go to the same directory as all bpel JAR files and MscJarBuild.xml.

• Create a script a.sh according to the example below:
export WL_HOME=/slot/ems2995/appmgr/Oracle/Middleware
export JDK_HOME=/slot/ems2995/appmgr/Oracle/Middleware/jdk160_11
export ANT_HOME=$WL_HOME/modules/org.apache.ant_1.7.0
export JAVA_HOME=/slot/ems2995/appmgr/Oracle/Middleware/jdk160_11
export BEA_HOME=/slot/ems2995/appmgr/Oracle/Middleware
export 
PATH=/slot/ems2995/appmgr/oracle/produc/11.1.1/as_1/bin:$WL_HOME/
modules/org.apache.ant_1.7.0/bin:$PATH
ant -f MscJarBuild.xml  -DnewDbConnName=CustomerDBConnection 
-DnewDwURL=http://rws60051rems.us.oracle.com:7870/mz1dv220 
-DnewSoaURL=http://
rws60018rems.us.oracle.com:8880

• Change all the environment variables to correspond to your environment 
setting, and then run the script.

5. In the WebLogic Enterprise Manager window, right-click <SOA_DOMAIN> and 
select SOA Deployment > Deploy.

Deploy all the .jar files from directory ../EbsModifiedBpelJars directory in the 
following order:
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1. sca_check_Dematra_Workflow_Process_Status.jar

2. sca_checkProcessStatus.jar

3. sca_Approve_Consensus_Demand_Process.jar

4. sca_ASCP_Collections_Process.jar

5. sca_Demantra_Collections_Process.jar

6. sca_Upload_Forecast_Process.jar

7. sca_Run_Supply_Plan_Process.jar

8. sca_Review_Supply_Plan_Process.jar

9. sca_Review_Process.jar

10. sca_Forecast_Inventory_SupplyPlan_Process.jar

11. sca_Sales_And_Operations_Planning_Process.jar

12. sca_MscReceiveUpdateFromOtm.jar

Set Up Profile Options
Perform the procedure below to set up your profile options.

1. Navigate to your e-Business Suite environment.

2. Select responsibility System Administrator.

3. Navigate to Profiles > System.

4. Verify or set values for the profile options as displayed in the table below.

Profile Options

Number / 
Owner

System Profile 
Name

User Profile 
Name

Valid Values / 
Set To

Comments

1 MSC_WC_ENA
BLED

MSC: APCC 
Webcenter 
Enabled

Yes/No -
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Number / 
Owner

System Profile 
Name

User Profile 
Name

Valid Values / 
Set To

Comments

2 MSC_WC_SPA
CES_MEMBER
ROLE

MSC: APCC 
Webcenter 
Spaces Member 
Role

Viewer Or 
Participant

Members added
to the 
webcenter 
group space can
be either 
viewers or 
participants.

3 MSC_WC_SPA
CES_TEMPLAT
E

MSC: APCC 
Webcenter 
Group Space 
Template

Webcenter 
Group Space 
Template Name

Example

Basic

4 MSC_WC_SPA
CES_RECIPIEN
TKEYALIAS

MSC: APCC 
Webcenter 
Spaces 
Recipient Key 
Alias

Recipient Key 
Alias

Example

Producer

5 MSC_WC_SPA
CES_SAMLISS
UERNAME

MSC: APCC 
Webcenter 
Spaces Saml 
Issuer Name

Saml issuer 
name of 
Webcenter

Example

www.oracle.co
m

6 MSC_WC_SPA
CES_PORT

MSC: APCC 
Webcenter 
Spaces Port

Webcenter 
Spaces 
managed server
Port

Example

8877
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Number / 
Owner

System Profile 
Name

User Profile 
Name

Valid Values / 
Set To

Comments

7 MSC_WC_URL MSC: APCC 
Webcenter URL

Webcenter URL Example
http://rws60
018rems.us.o
racle.com/we
bcenter/wcAu
thentication
/?login=true
&success_url
=/spaces

Replace your 
host and keep 
the other things 
same. Then, you
skip the 
Webcenter 
welcome/login 
screen when 
navigating from
e-Business Suite
to Webcenter.

8 MSC_SCN_SER
VICE_ENDPOI
NT

MSC: BPEL End
Point URI

WebLogic Soa 
server url

Example
http://rws60
212resm.us.o
racle.com:88
80

8880 is the 
soa_server1 
port number.

9 MSC_SCN_BPE
L_DOMAIN

MSC: BPEL 
Domain Name

soa-infra For example, 
soa-infra.

10 MSC_WS_WEB
LOGIC_USERN
AME

MSC: APCC 
WebLogic 
Username

Oracle BPM 
worklist admin 
user

Example

weblogic_admi
n

This user 
should be 
admin for OID 
and Webcenter.
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Number / 
Owner

System Profile 
Name

User Profile 
Name

Valid Values / 
Set To

Comments

11 MSC_WS_WEB
LOGIC_PASSW
ORD

MSC: APCC 
WebLogic 
Password

Oracle BPM 
worklist admin 
password.

Example

welcome1

12 MSC_WC_WEB
LOGIC_USERN
AME

MSC: APCC 
WebLogic 
Console 
Username

WebLogic 
admin user

Example

weblogic

This user 
should be the 
admin user for 
Weblogic.

13 MSC_WC_WEB
LOGIC_PASSW
ORD

MSC: APCC 
WebLogic 
Console 
Password

Set it to 
WebLogic 
admin 
password.

Example

welcome1

Compile MscWCRedirect.jsp
Perform the procedure below to compile the MscWCRedirect.jsp file. 

1. Log in to the middle tier where $APPL_TOP resides as an appmgr user

2. Execute the following command: 
cd $FND_TOP/patch/115/bin;

3. Compile and flush as follows:
perl ojspCompile.pl --compile -s 'MscWCRedirect.jsp' –flush

4. Restart the middle tier as follows:
cd $ADMIN_SCRIPTS_HOME;
adoacorectl.sh stop;
adoacorectl.sh start;
adoacorectl.sh status;

Run the Planning Process Activities Concurrent Process
Perform the procedure below to run the Planning Process Activities concurrent process.

1. Run the Planning Process Activities concurrent process.

2. Log in to http://rws60018rems.us.oracle.com:7004/em using the WebLogic admin 
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user.

3. Navigate to SOA > soa-infra.

4. Click Deployed Composite. Verify that there is a green dot before each flow name 
and that there is a green up arrow in each status. If there is not, undeploy the flow, 
restart the server, deploy the flow, and check it again.

5. Select responsibility Advanced Planning Scenario Manager. 

6. Run concurrent process Planning Process Activities concurrent process. This 
populates the Oracle 11g BPEL flows into the MSC tables.

Change the Webcenter Application Name
Perform the procedure below to change the Webcenter application name. 

1. Log in to Webcenter using administrator.

2. Click the Administration link at the top of the page.

3. Select the General tab.

4. Change Application Name to Value Chain Planning.

5. Click Apply.
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3
Production Scheduling

This chapter covers the following topics:

• Production Scheduling Implementation

• Mandatory Prerequisite Patches

• Mandatory Prerequisite Patches for Oracle Process Manufacturing (OPM) Users

• Post Installation Settings

• Special Instructions

Production Scheduling Implementation
The procedures described in this section are only required if you implement Production
Scheduling Integration V2 with E-Business Suite.

Mandatory Prerequisite Patches
Source Side:

Apply the following patches only if you are using Production Scheduler integrated with
Complex Maintenance Repair Overhaul (CMRO):

• 9413058:R12.EAM.B - EAM patch

• 9138126:R12.EAM.B - EAM patch

• 9377683:R12.AHL.B - CMRO patch

Mandatory Prerequisite Patches for Oracle Process Manufacturing (OPM) 
Users

The following patches are required for Oracle Process Manufacturing (OPM) users 
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when implementing Production Scheduling:

• 9319734:R12.GMP.B (with the following pre- requisites)

• 8486861:R12.GMA.B (with the following pre- requisites)

• 7587155:R12.INV.B

• 7627262:R12.INV.B

• 7015717:R12.GMP.B

Post Installation Settings
Set the following Profile option settings after Production Scheduling is installed:

• "MSC: PS/SNO API Version" should be set to 3.5 at Site Level.

• "MSC: PS/SNO Data Store Path" should be set to the value of $APPLCSF 
environment variable at Site Level. This variable is defined in "APPLSYS.env". 

• "MSC: PS/SNO Use DB for Integration Data" should be set to YES if Concurrent Tier
and Web Tier are on different machines.

• "MSC: PS/SNO Download XML Files" should be set to YES if users want to 
download the xml files to the client machine for debugging purpose. The default 
value is NO.

• "MSC: Collect CMRO Work Order Demand for PS" to "Yes" to enable the collection 
of CMRO Work Order demands when running the VCP collections process.

For users using Windows server for PS V2 integration, the system variables below need 
to be set in the server. This is a one-time mandatory step.

• SCP_ROOT_DRIVE has to be set with the drive where the Oracle product is 
installed. For example, C: 

• SCP_MSC_TOP has to be set with the MSC_TOP value with forward slash. 

Example
C:/oracle/VIS/apps/apps_st/appl/msc/12.0.0

• Restarting the machine is needed to make these environment variables take effect. 

• Profile option "MSC: PS/SNO Data Store Path" should be set with the forward slash.

Example
C:/u01/oracle/viscomn/admin
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Special Instructions
Review the following when implementing Production Scheduling:

• If RMO (Oracle Repetitive Manufacturing Optimization) option is licensed along 
with Production Scheduling application, the profile option "MSC: PS Enable CRO 
Scheduling" must be set to "YES". RMO and CRO are synonymous.

• Please un-install Production Scheduler application from your client machine and 
re-install again through the Workbench. This step helps to get the latest Production 
Scheduler build on the client.

• Production Scheduler is English only. The EBS translations can be downloaded 
from My Oracle Support as they become available. 

• As part of your setup, you should ensure that you assign the Production Scheduler 
responsibility to the appropriate user. 

• Please ensure that Organization security is enabled for Production Scheduler 
responsibility.

• After patch application it is recommended to restart the application server.





Strategic Network Optimization    4-1

4
Strategic Network Optimization

This chapter covers the following topics:

• Strategic Network Optimization Integration

• Mandatory Prerequisite Patches for Oracle Process Manufacturing (OPM) Users

• Post Installation Settings

• Special Instructions

Strategic Network Optimization Integration
The procedures in this section are only required if you implement Strategic Network 
Optimization Integration V2 with E-Business Suite.

Mandatory Prerequisite Patches for Oracle Process Manufacturing (OPM) 
Users

The following patches are required for Oracle Process Manufacturing (OPM) users 
when implementing Strategic Network Optimization:

• 9319734:R12.GMP.B (with the following pre- requisites)

• 8486861:R12.GMA.B (with the following pre- requisites)

• 7587155:R12.INV.B

• 7627262:R12.INV.B

• 7015717:R12.GMP.B
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Post Installation Settings
Set the following Profile option settings after Strategic Network Optimization is 
installed:

• "MSC: PS/SNO API Version" should be set to 3.5 at Site Level.

• "MSC: PS/SNO Data Store Path" should be set to the value of $APPLCSF 
environment variable at Site Level. This variable is defined in "APPLSYS.env". 

• "MSC: PS/SNO Use DB for Integration Data" should be set to YES if Concurrent Tier
and Web Tier are on different machines.

• "MSC: PS/SNO Download XML Files" should be set to YES if users want to 
download the xml files to the client machine for debugging purpose. The default 
value is NO.

• "MSC: SNO Publish on Client" should be set to YES if users want to publish the 
output xml files of SNO to the client under data_store/plan_id path. Setting the 
profile option to NO helps to improve SNO publish performance. The default value
is NO.

For users using Windows server for SNO V2 integration, the system variables below 
need to be set in the server. This is a one-time mandatory step.

• SCP_ROOT_DRIVE has to be set with the drive where the Oracle product is 
installed. For example, C: 

• SCP_MSC_TOP has to be set with the MSC_TOP value with forward slash.

Example
C:/oracle/VIS/apps/apps_st/appl/msc/12.0.0

• Restarting the machine is needed to make these environment variables take effect. 

• Profile option "MSC: PS/SNO Data Store Path" should be set with the forward slash.

Example
C:/u01/oracle/viscomn/admin

Special Instructions
Review the following when implementing Strategic Network Optimization:

• Please un-install Strategic Network Optimization application from your client 
machine and re-install again through the Workbench. This step helps to get the 
latest Strategic Network Optimization build on the client. 
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• Strategic Network Optimization is English only. The EBS translations can be 
downloaded from My Oracle Support as they become available. 

• As part of your setup, you should ensure that you assign the Strategic Planner 
responsibility to the appropriate user.

• Please ensure that Organization security is enabled for Strategic Planner 
responsibility. 

• After patch application it is recommended to restart the application server.
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5
Service Parts Planning

This chapter covers the following topics:

• Service Parts Planning Installation Updates

Service Parts Planning Installation Updates
There are no Service Parts Planning installation updates for Release 12.1.3.2.
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6
Demand Signal Repository

This chapter covers the following topics:

• Demand Signal Repository Implementation

• Setting Up Oracle Warehouse Builder (OWB)

• Setting Up Oracle Business Intelligence Enterprise Edition

• Setting Up Web Services

• Setting Up Demand Signal Repository - Demantra Integration

• Setting Up Demand Signal Repository - Retail Merchandising System (RMS) 
Integration

• Oracle Value Chain Planning - Oracle Transportation Management (OTM) 
Integration

Demand Signal Repository Implementation
Please follow the procedures in this section to implement Oracle Demand Signal 
Repository (DSR).

Prerequisites
Verify the following prerequisites:

• Oracle Database 11gR2 must be installed.

• Oracle Warehouse Builder (OWB) 11gR2 must be installed. Please refer to Oracle 
Data Warehouse Builder installation documents. 

• Oracle Warehouse Builder Patch 9403153 must be applied. Please refer to the 
instructions in the patch readme for application instructions.

• Perform fresh Install (skip this step if completed already). Install and set up 
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11gR2 Client and 11gR2 repository. Detailed instructions are listed in the Oracle
Warehouse Builder Installation and Administration Guide here: 
http://download.oracle.com/docs/cd/E11882_01/owb.112/e17130/toc.htm

• Upgrade from previous OWB versions (skip this step if completed already). For
users upgrading from 10.2.0., 10.2.0.2, 10.2.0.3 or 10.2.0.4 to 11gR2 client, the 
following document lists the steps required for the upgrade to 11gR2: 
http://download.oracle.com/docs/cd/E11882_01/owb.112/e17130/migrate.htm#C
HDFEBII

• Oracle Business Intelligence Enterprise Edition 10.1.3.4 must be installed. Please 
refer to Oracle Business Intelligence Enterprise Edition installation documents. 

• If you are planning to use Demand Signal Repository and Retail Merchandising 
System (RMS) integration you must install Oracle Data Integrator version 10.1.3.5, 
Retail Merchandising System (RMS) version 10.0 or higher and JRE version should 
be 6.0 or higher. 

Known Issues
Oracle Warehouse Builder (OWB) code generation bug #9543458 and #9544083 #9580806
in certain circumstances might result in incorrect map code generation. This would in 
certain cases also result in DSR providing incomplete error message in error tables 
about records being processed. Please refer Oracle Warehouse Builder (OWB) bug 
#9543458, bug #9544083 and bug #9580806 and related bugs for more details and 
solution.

Setting Up Oracle Warehouse Builder (OWB)
Perform the procedures below to setting up Oracle Warehouse Builder for your 
Demand Signal Repository implementation.

Setting Up the Demand Signal Repository Project 
Perform the procedure below to set up the Demand Signal Repository project.

Registering Users
1. Identify the target schema. The readme lists steps for deployment in the "APPS" 

schema, which is recommended. Additional setup not detailed in this document is 
required if schema other than "APPS" is used.

2. Create a user for the repository. The steps for creating the user can be found here: 
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/setup_windows.ht
m#insertedID3

http://download.oracle.com/docs/cd/E11882_01/owb.112/e17130/toc.htm
http://download.oracle.com/docs/cd/E11882_01/owb.112/e17130/migrate.htm#CHDFEBII
http://download.oracle.com/docs/cd/E11882_01/owb.112/e17130/migrate.htm#CHDFEBII
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/setup_windows.htm#insertedID3
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/setup_windows.htm#insertedID3
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3. Identify the workflow schema for process flows. Schema and location name are 
assumed to be to be "APPS" and "DSR_OWF_LOCATION" respectively for 
reference in the following sections of this document. Oracle Applications provides 
embedded Oracle Workflow in "APPS" schema. Please refer to Oracle Warehouse 
Builder Installation and Administration Guide installation instructions and other 
details if you need to perform standalone Oracle Workflow installation. 
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/toc.htm

4. Register the target schema 'APPS' and workflow schema 'APPS' as control center 
users. Please refer to the following document for more details on registering the 
users as control center users. 
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/control_ctr_mgmt.
htm#CHDHFAGC

Importing MDLs 
• All the Oracle Warehouse Builder project files are available in the following 

directory:
$DDR_TOP/patch/115/owb/US

• Import all MDL files. To preserve dependencies, import in the following order: 

1. Import ddrrcomn.mdl and ddrbcomn.mdl files.

2. Import all other mdl files except ddrrefpf.mdl. 

3. Import ddrrefpf.mdl file. 

Import Options - Using the Design Center
1. Place the MDL files in a directory with appropriate read and write permissions. 

2. From the File menu option, select Import > Warehouse Builder Metadata option 
from the menu. The Import Metadata dialog box appears. 

3. Browse the MDL file to be imported and select a file based on the sequence given 
above. 

4. Choose Import all objects from file under object selection. 

5. Select the Update Meta data (replace existing objects and create new metadata) 
option under Import option.

6. Select Match By Name under Match By option. 

7. Click Import.

8. Monitor the process and click on import summary to check for any errors.

http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/toc.htm
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/control_ctr_mgmt.htm#CHDHFAGC
http://download.oracle.com/docs/cd/E14072_01/owb.112/e10579/control_ctr_mgmt.htm#CHDHFAGC
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Import Options - Using OMBPlus Utility with the OMBIMPORT Command
1. Refer to the link below for a detailed explanation of the OMBIMPORT usage.

http://download.oracle.com/docs/cd/E11882_01/owb.112/e10584/toc.htm

Sample format of Import command: 
OMB+> OMBIMPORT MDL_FILE '<mdl name and path> ' USE UPDATE_MODE MATCH_BY
NAMES OUTPUT LOG TO 'log name and path' 

It is recommended that the customer maintain an import script that can be run from the 
OMBPlus console. This will reduce the effort and time to import the MDL files and also 
take care of all the dependencies automatically.

Creating Locations
• Identify the target schema and login credentials, host, port and sid. Assumed to be 

"APPS" schema in the following sections in this document.

• Identify the workflow schema and login credentials, host, port and sid. Assumed to 
be "APPS" schema in the following sections in this document.

• Create target location.

The name of the location is assumed to be <DSR_APPS_LOCATION> for reference 
in the following section of the document. Refer to the following document for more 
details on creating locations: 
http://download.oracle.com/docs/cd/E11882_01/owb.112/e10935/toc.htm

• Create workflow location.

The name of the location is assumed to be <DSR_OWF_LOCATION> for reference 
in the following section of the document. Refer to the following document for more 
details on creating locations: 
http://download.oracle.com/docs/cd/E11882_01/owb.112/e10935/toc.htm

Setting Up Project Module Location
1. In the Project Explorer window, expand project 

DEMAND_SIGNAL_REPOSITORY. 

2. Locate and expand the module Databases and Oracle. 

3. Double-click on the DEMAND_SIGNAL_REPOSITORY_ETL module. 

4. Select the Metadata Location tab. 

5. Choose the Location as <DSR_APPS_LOCATION>.

6. Select Data Location and select the <DSR_APPS_LOCATION> from the Available 
Locations list. 

7. Click OK. Ignore any warnings for the configuration if displayed. 

http://download.oracle.com/docs/cd/E11882_01/owb.112/e10584/toc.htm
http://download.oracle.com/docs/cd/E11882_01/owb.112/e10935/toc.htm
http://download.oracle.com/docs/cd/E11882_01/owb.112/e10935/toc.htm
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8. Right-click on the DEMAND_SIGNAL_REPOSITORY_ETL module and select 
Configure from the menu. 

9. In the details dialog, select the Location and Streams Administrator Location as 
<DSR_APPS_LOCATION>. Click OK.

Setting Up the Process Flow Module Location
1. In the Project Explorer window, expand project 

DEMAND_SIGNAL_REPOSITORY. 

2. Locate and expand the Process Flows module. 

3. Expand Process Flow Modules and double-click on the 
DSR_OTHER_PROCESS_FLOWS module. 

4. Select Data Locations tab and select "DSR_OWF_LOCATION" or equivalent 
workflow location from the Available Locations list. 

5. Click OK and ignore any warnings for the configuration if thrown. 

6. Right-click the DSR_OTHER_PROCESS_FLOWS module and select Configure from
the menu. 

7. In the details dialog, select the "Evaluation Location" as "Use default location" and 
"Location" as <DSR_OWF_LOCATION>. Click OK.

8. Follow steps 1 to 7 listed above for other process flow modules. Set up 
"DSR_DEMANTRA_INTEGRATION" process flow only if you are planning to 
deploy and implement integration with Demantra. 

Creating File Locations
1. Create a New FILE location: 

• In Oracle Warehouse Builder design center, go to "Connection Explorer," 
right-click on the Files node and select New. 

• Provide the location, a name, and point it to the directory location for TDLINX 
csv file. 

2. Set up external file: 

• In Oracle Warehouse Builder design center, expand the File node in Project 
Explorer.

• Right-click the module under the File node, and select Open Editor. 

• Metadata Location tab: Select the location, the FILE location set earlier in step 1 
above. 
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• Data Location tab: Select the FILE location set earlier. 

• Right-click and select Configure. Select the FILE location set earlier. 

• Open DDR_TDLINX_STR_DATA node under External Files and set the Default
Physical File Name to the name of the tdlinx data file. 

3. Set up external table: 

• In Oracle Warehouse Builder design center in "Project Explorer," right-click on 
the "External Table" and select Open Editor. 

• Locations tab: Select file location set above in step 1. 

• Right-click and select Configure. 

• Select the locations for: Bad file, Discard file and Log file. 

Setting Up Control Center
• Identify the control center users' login credentials. 

• Identify the control center schema, host, port, sid information. 

• Identify the locations to be registered as source and targets depending on the 
repository configuration. 

• Set up Control Center. 

1. In the Connection Explorer window, expand Control Centers. 

2. Right-click and select New from the menu. 

3. Provide a name to the control center <DSR_CONTROL_CENTER>.

4. Click Test Connection to see if the set up is correct and click OK. 

5. Double-click on the control center created above and select the Data Locations 
tab. 

6. Select required locations from the Available Locations list. Usually source, 
target and workflow and files locations are selected here. 

• Configure the Project. 

1. In the Project Explorer window, expand project 
DEMAND_SIGNAL_REPOSITORY. 

2. Locate and expand the Configurations module. 
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3. Right-click on the configurations and select New from the menu. 

4. Specify a name for the configuration, and select the Set and save as my Active 
Configuration for this Project check box. Click Next. 

5. Select the control center from the list and click Next. 

6. Review the details and click Finish. 

Deployment
Perform the following during the deployment process:

• Before deploying DDR_B_SL_RTN_ITEM_IS_MAP - right click on the map name in
the navigator and select configure and in the properties panel under "Code 
Generation Options" change "ANSI SQL Syntax" to false.

• All the mappings and processes flows provided should be deployed, except for the 
mapping provided for Demantra integration "DDR_DMNT_INTG_MAP". The 
Demantra mapping are only required if you intend to integrate Demand Signal 
Repository with Demantra. This mapping is used to import store data from 
syndicated store reference data source. 

• Deployment can be performed at the individual object level or in bulk. The 
deployment can be performed from the design editor or the control center. Please 
refer to the Oracle Warehouse Builder User Guide for more details. 

• If you plan to import store data from syndicated store reference data source deploy 
the External Table first and then proceed to deploying the other maps and process 
flows. 

Setting Up Oracle Business Intelligence Enterprise Edition
Install Oracle Business Suite Intelligence Enterprise Edition (OBIEE) 10.1.3.4. 

Refer to the Oracle Business Suite Intelligence Enterprise Edition 10.1.3.4 
documentation for details.

Setting Up the Oracle Business Intelligence Enterprise Edition Infrastructure
Files ddrpd.zip and ddrwebcat.zip contain the following files for use with the Oracle 
Business Intelligence Suite Enterprise Edition 10.1.3.4: 

• DSR_Reports.rpd - This is the Oracle Demand Signal Repository product repository
file; contained in ddrrpd.zip 
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• DSR_Reports - This directory is the Oracle Demand Signal Repository product Web 
catalog; contained in ddrwebcat.zip 

Copy these ZIP files (ddrrpd.zip, ddrwebcat.zip) from obiee 
($DDR_TOP/patch/115/obiee) directory. 

Unzip ddrrpd.zip to get DSR_Reports.rpd. 

Copy the DSR_Reports.rpd file to repository subdirectory of the Oracle Business 
Intelligence Enterprise Edition server.

• On a Windows system, the Oracle Business Intelligence Enterprise Edition server is 
usually installed in the "OracleBI" directory. You can copy the appropriate the file 
using Windows Explorer, or execute a command from a command prompt as 
shown in the following example: 
copy DSR_Reports.rpd ORACLE_HOME\server\repository

• On UNIX or Linux-based systems, you can copy the appropriate directory by 
executing a command similar to the one shown in the following example: 
cp DSR_Reports.rpd ORACLE_HOME/server/repository 

Enable the use of "Oracle Demand Signal Repository" repository file:

• Update the NQSConfig.INI file of the Oracle Business Intelligence Enterprise 
Edition Infrastructure by replacing the line that starts with the word "Star = " with 
"Star =DSR_Reports.rpd, DEFAULT;".

• Refer to "Updating Oracle BI Server Configuration Settings" in the Oracle Business 
Intelligence Infrastructure Installation and Configuration Guide for more details. 

• Set up database connection details. 

1. Open DSR_Reports.rpd in Oracle Business Administration Tool using 
Administrator/Administrator as username/password. 

2. In the physical layer, change the username/password for the database 
connection in DDR connection Pool.

3. Add entry for the database in the correct TNSNAMES.ora file.

Setting Up the Oracle Business Intelligence Enterprise Edition Presentation Services
Perform the following to set up the Oracle Business Intelligence Enterprise Edition 
Presentation Services.

1. Unzip ddrwebcat.zip to get DSR_Reports Web catalog. 

2. Copy the catalog directory into the Oracle Business Intelligence Enterprise Edition 
Presentation server.



Demand Signal Repository    6-9

• On a Windows system, the Oracle Business Intelligence Enterprise Edition 
presentation server is usually installed in the "OracleBIData" directory. You can 
copy the appropriate the file using Windows Explorer, or execute a command 
from a command prompt as shown in the following example:
xcopy /E /I DSR_Reports ORACLE_HOME\web\catalog

Note: On Windows 2003, this command copies over the folder 
contents to the location from where the command was 
executed. Please use Windows Explorer for copying over this 
folder to the required location. 

• On UNIX or Linux-based systems, you can copy the appropriate directory by 
executing a command similar to the one shown in the following example
cp -rf DSR_Reports ORACLE_HOME/web/catalog

Setting Up Oracle Business Intelligence Enterprise Translation 
Perform this setup only if you are planning to use translated OBIEE UI. This process 
uses the "transx" utility that is part of the Oracle DB install.

1. Configure Transx using the instructions provided at the link below: 

http://www.oracle.com/technology/tech/xml/xdk/doc/production10g/doc/java/Getti
ng_Started_Java.html

Note: The above instructions are valid if you have Oracle 10g 
database installation. 

The instructions are specifically for Windows-based standalone setup. 

The directory paths will change based on the install directory used. Please use the 
sample setup below as guideline.

• In Window Environment, right-click My Computer icon and select Properties. 

• Select the Advanced tab in System Properties.

• Click Environment Variables and setup CLASSPATH, CLASSPATHJ, 
JAVA_HOME, XDX_HOME variables.

Sample Variables Setup for Database 10g

http://www.oracle.com/technology/tech/xml/xdk/doc/production10g/doc/java/Getting_Started_Java.html
http://www.oracle.com/technology/tech/xml/xdk/doc/production10g/doc/java/Getting_Started_Java.html
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%CLASSPATH==>.;%CLASSPATHJ%;C:\Apps\db\oracle102\LIB\xmlparserv2.
jar;C:\Apps\db\oracle102\LIB\xschema.jar;C:\Apps\db\oracle102\LIB
\xsu12.jar;C:\Apps\db\oracle102\LIB\oraclexsql.jar;C:\Apps\db\ora
cle102\LIB\classgen.jar;C:\Apps\db\oracle102\LIB\transx.zip;C:\Ap
ps\db\oracle102\jdbc\lib\classes12dms.jar;C:\Apps\db\oracle102\jd
bc\lib\ojdbc14.jar;C:\Apps\db\oracle102\LIB\servlet.jar;C:\Apps\d
b\oracle102\RDBMS\jlib\xdb.jar

%CLASSPATHJ ==> 
C:\Apps\db\oracle102\jdbc\lib\classes12.zip;C:\Apps\db\oracle102\
jdbc\lib\nls_charset12.jar

%JAVA_HOME ==> D:\jdk1.5.0_09

%ORACLE_HOME ==> C:\Apps\db\oracle102

Sample Variables Setup for Database 11g
JDBCVER==>6

JDKVER==>1.6.0_11   

CLASSPATH==>.;%CLASSPATHJ%;%ORACLE_HOME%\LIB\xmlparserv2.jar;%ORA
CLE_HOME%\LIB\xschema.jar;%ORACLE_HOME%\LIB\xsu12.jar;%ORACLE_HOM
E%\LIB\oraclexsql.jar;%ORACLE_HOME%\LIB\classgen.jar;%ORACLE_HOME
%\LIB\transx.zip;%ORACLE_HOME%\LIB\xmlcomp.jar;%ORACLE_HOME%\LIB\
xmlcomp2.jar;%ORACLE_HOME%\LIB\xmlmesg.jar

CLASSPATHJ==>%ORACLE_HOME%\jdbc\lib\ojdbc%JDBCVER%.jar;%ORACLE_HO
ME%\jlib\orai18n.jar;%ORACLE_HOME%\RDBMS\jlib\xdb.jar;%ORACLE_HOM
E%\LIB\jde-rt.zip;%ORACLE_HOME%\RDBMS\jlib\xdb.jar;%ORACLE_HOME%\
oui\jlib\classes12.jar;%ORACLE_HOME%\jdbc\lib\classes12.zip

JAVA_HOME==>C:\Oracle\Middleware\jdk160_11

ORACLE_HOME==>C:\app\MP17603\product\11.1.0\db_1

PATH==>%JAVA_HOME%\bin;%ORACLE_HOME%\bin;%PATH%

2. The OBIEE translated files are shipped under <$DDR_TOP>/patch/115/obiee 
directory and are named as ddr_obiee_<language id>.zip (for example, 
ddr_obiee_fr.zip). 

3. Unzip the language zip file to be used to a local drive (for example, c:\ drive). The 
DLF files will be extracted into the C:\ddr\OracleBI\Repository directory. 

4. Import the files into the DB by executing the following transx command: 
transx "hostname:port:sid" username password filename 

For example, to load the Spanish translation version you might use the following:
c:\transx rws60147rems:1524:mz1dv220 apps apps ddr_es.dlf

5. Verify the seeding data gets uploaded correctly in DDR_TRANSLATED_MESSAGE
by the following query:
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SELECT Count(*)
FROM DDR_TRANSLATED_MESSAGE
GROUP BY lang_id='<language id>'

6. Copy the files sopcaptions.xml, scacaptions.xml and scrmcaptions.xml if available 
from 
ddr\OracleBIData\l_<language id>

into
<..>\OracleBIData\web\res\l_<language id>\Captions

If the directory l_<language id>is not there, then perform:
create subdirectory l_<language id>>\Captions 

under OracleBIData\web directory. 

7. Restart the BI servers to verify the translation. 

8. To use the translated UI, select an appropriate language and then enter user 
id/password when you log in to Presentation Service. 

Setting Up the Exception Management Dashboard Feature
Perform the set up described in this section only if you plan to use the exception 
management dashboard feature.

1. Copy <product_top>/patch/115/obiee/java/DDRExceptionHandler.jar file to 
$HOME/OracleBI/web/javahost/lib on the BI server. 

This enhancement uses iBots that require OBIEE Scheduler be set up.

For complete set-up instructions please refer to Oracle Business Intelligence 
Infrastructure Installation and Configuration Guide, Chapter 10, "Configuring Oracle BI
Scheduler." 

This enhancement uses a custom Java program to write exceptions to the database. 
This custom Java program requires a 'dbConnection.properties' file for database 
access information. 

2. Create a text file named "dbConnection.properties". 

The content of the file should be set-up like example below.

Example File
driver=oracle.jdbc.driver.OracleDriver
connection_url=jdbc:oracle:thin:@servername.oracle.com:1524:mydataba
se
user=apps
password=<apps_password>

Note: If you do not want to expose "APPS" schema password in the 



6-12    Oracle Value Chain Planning Installation Guide

file, perform the following: Create a database a new database user 
ddremd and grant execute privilege on ddr_emd_util package in 
apps schema to this user. 

You may use following sample commands to create user and 
grantprivileges:
create user ddremd identified by ddremd
grant execute on apps.ddr_emd_util to ddremd;

3. Modify the CLASSPATH in the javahost config file, located at 
$HOME/OracleBI/web/javahost/config/config.xml to make sure 
$HOME/OracleBI/web/javahost/lib/DDRExceptionHandler.jar file is in the class 
path. 

Sample CLASSPATH configuration:
<Loader>

<Name>Scheduler</Name>

<Class>com.siebel.analytics.scheduler.Javahostrpccalls.SchedulerComp
onentLoader</Class>

<ConfigNodePath>Scheduler</ConfigNodePath>

<ClassPath>{%javahostdir%}/lib/scheduler/schedulerrpccalls.jar;

{%javahostdir%}/lib; 
C:/Oracle/OracleBI/oc4j_bi/jdbc/lib/ojdbc14dms.jar;
C:\Oracle\OracleBI\oc4j_bi\lib\dms.jar;

C:/Oracle/OracleBI/web/javahost/lib/DDRExceptionHandler.jar</ClassPa
th>

</Loader>

Setting Up Web Services
Demand Signal Repository provides a set of Web services that can be optionally 
deployed. Implementers can use these Web services to automate their processes or 
perform integration with 3rd party systems. 

Prerequisites
SOA Suite 10.1.3.3 must be installed.

Deploying Web Service
1. Log on to Oracle Application Server Control, click the name of the OC4J instance 

you want to deploy to (example: home). 
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The Web services delivered in Oracle Demand Signal Repository as part of this 
Maintenance Pack appear in the table below.

Description Web Service File Deployed Application in 
Application Server

Demand Signal Repository 
Fact Data Webservice

ddrwsfal.ear DDR_WS1.0

2. To deploy the Web service, perform the following: 

• For a given application, if it has been deployed previously, please first 
undeploy it before deploying it again.

• Select the Application tab, and then click Deploy button. 

• On "Archive Location", click browse and select the following:
<DDR TOP>/patch/115/ear/ddrwsfal.ear 

• In Step 2, click Next . 

• In Step 3, click Deploy. The Web service is now deployed. 

• Repeat for each of the EAR files. 

3. Update Connection Pool. 

• For the deployed application, go back to the corresponding Applications screen.

• Click Administration, and then click JDBC Resources. 

• Click the connection pool named 
"jdev-connection-pool-CustomerDBConnection". 

• In the URL field, please enter proper host name, port name and database 
connection information for the EBS database. There may already be an example 
value entered "ap619sdb.us.oracle.com:20105:MZ121DV1". If present, replace it. 

• Set the Username field to the APPS database username, set the password. Click 
Apply. If users would like to avoid using clear text passwords, please see 
password indirection and password obfuscation sections in Oracle Containers for
J2EE Security Guide. 

• Click Apply. 
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4. Re-start the SOA Application Server.

Setting Up Demand Signal Repository - Demantra Integration
Customers who want to use Oracle Demantra Release 7.2 with DSR should apply the 
script msddemcrwf3.sql to create the series, integration profiles, and workflows 
required for the integration. 

The SQL file is not executed during patch application. It must be applied manually. 

The SQL file location is as follows: 
$MSD_TOP/patch/115/sql/msddemcrwf3.sql 

Case 1: DSR (APS) and Demantra on the Same Database Instance
1. Make sure that the profile 'MSD_DEM: Schema' is set to the correct Demantra 

Schema name. 

2. Make sure the Demantra installation is not in use for any activity. 

3. Apply the SQL File msddemcrwf3.sql in the APPS schema. 

4. Bounce the Demantra Application Web Server. 

5. Create a synonym named 'BIIO_DSR_SALES_DATA' in the APPS schema of the 
instance where DSR is installed. 

This synonym should point to the table 'BIIO_DSR_SALES_DATA' in the Demantra
Schema. For example, if the Demantra schema name is 'DMTRA_TEMPLATE', then 
create the synonym by running the following command in the APPS schema:
CREATE OR REPLACE SYNONYM BIIO_DSR_SALES_DATA FOR 
DMTRA_TEMPLATE.BIIO_DSR_SALES_DATA 

Case 2: Demantra on Separate Database Instance
1. Create the package MSD_DEM_DEMANTRA_UTILITIES in the Demantra schema 

by applying the following files 

• $MSD_TOP/patch/115/sql/msddemdus.pls - Package Specification 

• $MSD_TOP/patch/115/sql/msddemdub.pls - Package Body 

2. Make sure the Demantra installation is not in use for any activity. 

3. Apply the SQL File msddemcrwf3.sql in the Demantra schema. 

4. Bounce the Demantra Application Web Server. 
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5. Create a synonym named 'BIIO_DSR_SALES_DATA' in the APPS schema of the 
instance where DSR is installed. This synonym should point to the table 
'BIIO_DSR_SALES_DATA' in the Demantra Schema. 

Setting Up Demand Signal Repository - Retail Merchandising System 
(RMS) Integration

Please follow instructions in this section only if you are planning to implement Demand
Signal Repository integration with Retail Merchandising System (RMS).

Prerequisites
• Oracle Data Integrator (ODI) 10.1.3.4 must be installed and repositories created. 

Refer to ODI install documentation for information at the following link:

http://www.oracle.com/technology/products/oracle-data-integrator/10.1.3/htdocs/d
ocumentation/oracledi_setup.pdf 

• Verify that the java home is in the path variable, this can be set on Linux with 
"export PATH=$PATH:/dir", or in the environment variables on Windows. 

Setting Up Oracle Data Integrator (ODI) 
The required Oracle Data Integrator set up files are available through ddrrmsint.zip file.
The file is located under odi directory under Demand Signal Repository product 
directory.

Objects in the ZIP File
Topology Objects

These objects set up the database connections for the integration and must be modified 
in the ODI topology manager.

• CONT_RetailtoDSRContext.xml - Creates the context for ODI. 

• CONN_OracleDSRDS.xml - Establishes the physical connection to the DB where the
DSR tables are. 

• CONN_RETLDLPRDDS.xml - Establishes the physical connection to the .dtd file for
the XML format. 

• LSC_OracleDSR.xml - Establishes the logical connection for the DSR DB which ties 
the physical connection and the context together. 

• LSC_RETLDLPRD.xml - Establishes the logical connection for the XML file which 

http://www.oracle.com/technology/products/oracle-data-integrator/10.1.3/htdocs/documentation/oracledi_setup.pdf
http://www.oracle.com/technology/products/oracle-data-integrator/10.1.3/htdocs/documentation/oracledi_setup.pdf
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ties the physical connection and the context together. 

Scenario Object

This object is the integration process within ODI.

• SCEN_LOAD_RETL_ITEMS_TO_DSR_PKG_SCENARIO Version 001.xml - The 
Process flow for running the integration. 

Java Class File

The Java program that converts the pre EDI 852 flat file generated by RMS to XML file 
format that can be used by ODI.

• DLPRDFileToXml Converter.class 

DTD File

This file defines the XML structure for the Java converter program and ODI.

• RETLDLPRD.dtd 

Configuring the User Parameters in DSR Lookups and Setting Up Integration Directories
Please refer Demand Signal Repository implementation guide for more information on 
how to set up the system parameters. 

The parameters specified below in the LKUP_CD column need to be configured and set 
up by the user. Sample values appear below. 

Parameter Parameter Value (Example 
values listed)

Purpose of the parameter

RETL_DSR_SRC_DIR ODI_HOME/retldsr/source The directory where the RMS 
EDIDLPRD File should be 
kept for upload to DSR. 

RETL_DSR_SRC_FILENAME EDIDLPRD.pc The RMS EDIDLPRD File 
name that needs to be loaded 
into Oracle DSR.

RETL_DSR_SUCCESS_DIR ODI_HOME/retldsr/sucess The directory where the RMS 
EDIDLPRD file should be 
moved after the successful 
upload.

RETL_DSR_FAILED_DIR ODI_HOME/retldsr/failed The directory where the RMS 
EDIDLPRD File should be 
moved after the upload fails.
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Parameter Parameter Value (Example 
values listed)

Purpose of the parameter

RETL_DSR_TO_ADDR user_name@ integrator.com The admin email address 
where the error or success 
notification should be sent.

RETL_DSR_FM_ADDR retl-dsr@integrator.com The Integrator admin email 
from which the error or 
success notification should be 
sent.

RETL_DSR_MAIL_SERVER Mail. integrator.com Mail Server that will send the 
ODI email notifications. 

RETL_DSR_CLASS_DIR ODI_HOME/retldsr/source The directory where the 
DLPRDFileToXMLConverter.
class file is located. 

Create the directories that were set up in the DDR_R_LKUP_MST table to be the source,
success, failure and class directories. 

Copying the Class and DTD Files to the Necessary Folders
1. Copy the class file DLPRDFileToXMLConverter.class from the temporary 

folder/src/class to the directory specified in the RETL_DSR_CLASS_DIR in the 
DDR_R_LKUP_MST Table. 

2. Copy the DTD file RETLDLPRD.dtd from the temporary folder/src/xml to the 
source directory specified in the RETL_DSR_SRC_DIR in the DDR_R_LKUP_MST 
Table. 

Setting Up the odiparams.bat /.sh File for Importing from Command Line
1. Go to the Oracle ODI Home /bin directory. 

2. Open the odiparams.bat (win) or .sh (UNIX) file for editing. 

3. Add the repository connection information, which should appear as follows:
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set ODI_SECU_DRIVER=oracle.jdbc.driver.OracleDriver
set ODI_SECU_URL=jdbc:oracle:thin:@<host>:<port>:<sid>
set ODI_SECU_USER=user for master repository
set ODI_SECU_ENCODED_PASS= use agent encode utility in bin dir to 
encode the user password
set ODI_SECU_WORK_REP=repository name
set ODI_USER=SUPERVISOR
set ODI_ENCODED_PASS=LELKIELGLJMDLKMGHEHJDBGBGFDGGHODI

Importing and Configuring the Topology Objects
Importing from Command Line (Preferred)

1. Make sure that the odiparams file is set to the ODI repository. 

2. From the command line run the following:
"startcmd.bat OdiImportObject -FILE_NAME= "<Insert the ODI object 
name and directory path>" -WORK_REP_NAME= ODI_WORKREP_PROJECT 
-IMPORT_MODE=SYNONYM_INSERT_UPDATE

3. Repeat this process for all 5 topology objects. 

4. Verify that all the objects were imported. 

• On the physical architecture tab under Oracle verify that tree structure of 
"Oracle DSR DS" and under that "Oracle DSR DS.DDR" were imported. 

• On the physical architecture tab under XML verify that tree structure of "RETL 
DLPRD DS" and under that "RETL DLPRD DS.RETLDLPRD" were imported. 

• On the logical architecture tab under Oracle verify that "Oracle DSR" was 
imported. 

• On the logical architecture tab under XML verify that "RETL DLPRD" was 
imported. 

• On the contexts tab verify that "Retail to DSR Context" was imported. 

Importing from UI

1. From ODI topology manager, select File > Import > Topology. 

2. From the import mode drop down, select Synonym Mode INSERT_UPDATE. 

3. Select Import From a Folder option. 

4. Click the Browse button to the right of the text box and select the temporary folder 
where retl_dsr_install was unzipped in. Select the folder retl_dsr_install > src > 
topology and click OK to start the import. 
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Configuring the Physical Architecture in Topology Manager
1. On the physical architecture tab under Oracle on the "Oracle DSR DS" object, 

change the JDBC URL to point to the DSR database.

Example
jdbc:oracle:thin:@yourserver:port:dbname 

2. On the "Oracle DSR DS.DDR", change the username and password for that 
connection. Click Test and make sure the connection is successful.

3. Under XML on the "RETL DLPRD DS", change the JDBC URL to point to the file 
RETLDLPRD.dtd in the source directory created. Click Test and make sure 
connection is successful.

Example
jdbc:snps:xml?d=directory_path_to_dtd_file/RETLDLPRD.dtd&s=RETLDLPRD
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Configuring the Context and Logical Architecture in Topology Manager
1. On the contexts tab, verify on the schemas tab for the "Retail to DSR Context" .

• Logical Schema "Oracle DSR" = "Oracle DSR DS.DDR" Physical Schema 

• Logical Schema "RETL DLPRD" = "RETL DLPRD DS.RETLDLPRD" Physical 
Schema 

2. On the logical architecture tab under Oracle, verify on the definitions tab for "Oracle
DSR" that Context "Retail to DSR Context" = "Oracle DSR DS.DDR" Physical 
Schema. 

3. On the logical architecture tab under XML verify on the definitions tab for "RETL 
DLPRD" that Context "Retail to DSR Context" ="RETL DLPRD DS.RETLDLPRD" 
Physical Schema. 
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Importing the Scenario Object in the Operator
Importing from Command Line

1. Make sure that the odiparams file is set to the repository. 

2. From the command line run the following: 
startcmd.bat OdiImportObject -FILE_NAME=

 ".\src\topology\CONT_RetailtoDSRContext.xml" -WORK_REP_NAME=

 ODI_WORKREP_PROJECT -IMPORT_MODE=SYNONYM_INSERT_UPDATE

Importing from UI

1. From ODI Operator, select the Scenario tab and then File > Import > Import 
Scenario. 

2. From the import mode drop down list, select Synonym Mode INSERT_UPDATE. 

3. Click the Browse button to the right of the text box, and select the folder where 
retl_dsr_install was unzipped in. Select the folder retl_dsr_install > src > scenario. 

4. Select the LOAD_RETL_ITEMS_TO_DSR_PKG object and click OK to start the 
import. 

5. Verify that the object gets imported. 

Executing the Scenario
1. When the EDI file is received, move it to the source directory that is set up in the 

variable RETL_DSR_SRC_DIR in the DDR_R_LKUP_MST table. 

2. Right-click the LOAD_RETL_ITEMS_TO_DSR_PKG object from the ODI Operator 
on the Scenario tab, and select Execute. 

3. On the variables to be used window, enter the RTL_ORG_CD. This is the code that 
represents the retailer in DSR. 

4. Tab out of the RTL_ORG_CD field, and click OK.

5. Select the Sessions List tab to check the status of the execution. 



6-22    Oracle Value Chain Planning Installation Guide

Oracle Value Chain Planning - Oracle Transportation Management (OTM) 
Integration

Setting Up Oracle Transportation Management (OTM) v60 to integrate with EBS 12.1.3
All customers using OTM version 6 in order to integrate with EBS 12.1.3 need to do the 
following on the OTM side:

1. The following steps need to be performed once on the OTM instance to have the 
XSL file available for use:

Get a copy of the "GLogXML v60 to v55 DateTime.xsl" and "GLogXML v60 to 
v55.xsl" files, the files are shipped with OTM in the 
{otm_install}/utils/integration/transform directory

Place the xsl files on the OTM server. There are two options:

• Manually copy the files to the xsl file location 
{otm_install}/glog/integration/client/xsl .Note that the actual location is 
indicated by the following OTM property : glog.integration.stylesheetRoot

• Upload the XSL files in the Integration Manager

• In OTM login as DBA.ADMIN (you can only upload the xsl files as 
DBA.ADMIN)

• Go to Business Process Automation > Integration >Integration Manager > 
Upload an XML/CSV Transmission

• Upload each of the XSL files

2. The following steps need to be performed for the External Systems configured to 
send to the BPEL flow:

• In OTM log in to the domain.

• Go to the External System you are using to send to BPEL, menu: Business 
Process Automation > Communication Management > External Systems.

• In the External System Manager, in the External System Translations section, 
enter the following:

• Sequence Number:1 (increase for each entry)

• Stylesheet Name : GLogXML v60 to v55 DateTime.xsl

• XML Element ID: chose the outbound interface or select "*" for all 
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interfaces.

• Leave the other fields in the grid empty and click Save to save the 
translation entry.

• Click Finished at the top of the page to save the External System. 
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7
Rapid Planning

This chapter covers the following topics:

• Rapid Planning Installation

Rapid Planning Installation
For information on Rapid Planning installation, refer to the following articles on My 
Oracle Support: 

• Value Chain Planning Installation Guide for Release 12.1.3 - note 1086459.1 
[https://support.oracle.com/CSP/main/article?cmd=show&id=1086459.1&type=NOT
].

• Rapid Planning Release Notes - Release 12.1.3 -  note 1081471.1 
[https://support.oracle.com/CSP/main/article?cmd=show&id=1081471.1&type=NOT
].

https://support.oracle.com/CSP/main/article?cmd=show&id=1086459.1&type=NOT
https://support.oracle.com/CSP/main/article?cmd=show&id=1081471.1&type=NOT
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8
Other Useful Information

This chapter covers the following topics:

• Troubleshooting

Troubleshooting
This section contains information that may be helpful when installing or 
troubleshooting your Value Chain Planning installation.

Issue Description

11g RDBMS Bug For any customers using 11g DB, when they 
launch collection, they may hit "glibc error", 
please apply RDBMS patch 7330434 to resolve 
this issue.

11g RDBMS Bug Customers using 11g database on their source 
instance may encounter RDBMS bug 7175822 
(Drop materialized view statement hits 
ORA-00060 error) when profile MSC: Source 
Setup Required is set to Yes. Customers are 
recommended to uptake RDBMS patch 
7175822 to resolve this. 
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